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About This Guide
This guide provides a step-by-step introduction to the Micro Focus Rumba Screen Designer.

The guide shows you how to:

• Create a history file
• Use the Rumba Screen Designer to customize a set of screens
• Test the customized screens
• Use the customized screens in the Rumba Desktop.

A comprehensive How To section provides further information about customizing screens and information
about exporting customized screens to Rumba+ Web and Rumba+ Mobile.

Note: You can only customize screens for 3270 mainframe and 5250 AS/400 (iSeries) sessions.

Who should read this guide
This guide is intended to be read by all those interested in customizing green screen applications to create
applications with a modern look and feel.

It is expected that readers would mostly be system administrators or other IT personnel with a similar level
of expertise.

Prerequisites
• Rumba Desktop 9.3
• Rumba+ Build Tool 1.2 for export to Rumba+ Mobile and Rumba+ Web

Accompanying files
The package file containing this guide also contains the following files:

• MF_logo.png

• pie_chart.png

• WebFrame_URL.txt

• welcome.png

If you do not have these files, you will not be able to complete some of the exercises in this guide.

Conventions used in this guide
The following typographic conventions are used in this guide:
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This typeface ... Is used for ...

Bold Windows user interface elements such as window titles, fields, and buttons.

Also used for keyboard keys.

Monospace Host user interface elements such as screen titles and labels.

Also used for file names as well as for text that you are asked to type.

Entering commands:

This instructon ... Means this...

Enter TSOA. Type the TSOA command, then press the Enter key.
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Introduction
You use the Screen Designer to provide a modern look and feel to green screen applications and make
them easier to use. You do this without touching any application code.

This guide provides instructions for you to start using the Screen Designer to customize green screens.

Note: For the purposes of this guide, only 3270 mainframe screens are used. However, you can also
use the same principles to customize 5250 AS/400 (iSeries) screens.

Terminology
Screen Designer

The customization engine for Rumba+. It consists of two parts:
Screen Design
Used to add static controls on top of specific screens.

Rule Manager
Used to add dynamic or conditional controls which target an entire green screen
application.

Control
A modern visual element that interacts with a green screen. For example, a button.

Rule
A mechanism that automatically creates one or more conditional controls on one or several
screens, managed by rules.
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How it works
The figure below provides an overview of what you do to create and use customized screens:

Architecture
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Using the Screen Designer
This section provides a step-by-step guide to creating a customization project. You add a number of
controls to various green screens to create a project, then see the results of the customization in Rumba+
mode.

Getting started
Before you start using the Screen designer, you need to:

• Extract the files that came with this guide.
• Start a mainframe session.
• Change the color of the screen text to make it more visible.
• Connect to the Rumba Demo Host.

Extracting the package files
Extract the following files from the package .ZIP file to your local machine:

• MF_Logo.png

• pie_chart.png

• WebFrame_URL.txt

• welcome.png

Make a note of where you save them because you will need them later.

Starting a mainframe session
1. From the Windows Start menu, select: 

Start > All Programs > Micro Focus Rumba > Micro Focus Rumba Desktop

The Welcome screen appears:
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2. Click Mainframe Display. 

A mainframe session window appears on the Rumba desktop.

Changing the display options
Some of the screens used by the Demo Host can be difficult to see because of the blue text color they use.
The simple solution is to change the color.

To do this:

1. Select Options > Display. 

The Display Options dialog box appears.

2. Click the Color Attributes tab.

3. In the Multi Color Attributes frame, click the Protected button. 

The color palette appears:

4. Click the light green box. 

The blue Protected button changes to green.

5. In the Extended Color Attributes frame, click the Blue button. 

The color palette appears:
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6. Click the light green box. 

The blue button changes to green.

7. Click OK. 

All dark blue text on screens will now appear as green.

Configuring the connection to the Demo Host
1. Select Connection > Configure. 

The Connnection Configuration window appears:

2. In the Auto Connection Options frame, check Auto Connect.

3. In the Installed Interfaces frame, select Demo Host from the list.

4. Click OK.
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5. Select File > Save session Profile As. 

The Save Session Profile dialog box appears.

6. In the File name field, type DemoHost.

7. Click OK. 

The Connnection Configuration window closes.

Creating a history file
Before you start customizing screens, you need to capture a set of screens in a history file. This section
describes how to record a sequence of screens to use in the Screen Designer.

Recording history
You need to create a history file so you have a set of screens to use in the Screen Designer. To do this:

1.
Click the History icon  on the Rumba toolbar. 

The History pane appears.

2.
Click the Record icon  on the History pane toolbar.

3. Select Connection > Connect. 

The Demo Host mainframe session starts:

4. Press Enter. 

The screen appears in the History pane.

The rest of the screens will be captured automatically.

5. At the ENTER SYSTEM ID : prompt, enter: 

TSOA

6. At the ENTER LOGON ID: prompt, press Enter.

7. At the LAST SYSTEM ACCESS prompt, press Enter.

8. At the READY prompt, enter: 

TOYS
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9. At the TOPCO TOYS, INC screen, press Enter.

10.Enter O.

11.At the CUSTOMER SCREEN, press PF8.

12.At the DETAIL LINE ENTRY SCREEN, press Enter.

13.At the READY prompt, enter: 

E

14.At the TOP OF DATA screen, press Enter.

15.At the READY prompt, enter: 

R

16.At the TOPCO TOYS, INC screen, press PF3.

17.At the READY prompt, enter: 

A

18.At the EXTENDED ATTRIBUTE TEST screen, press PF3.

19.At the READY prompt, enter: 

C

20.At the EUROPEAN CUSTOMER LIST screen, press PF1.

21.
Click the Record icon  again to stop recording history.

Each screen has been added, in sequence, to the History pane:

Recording a single screen
You can also record screens one at a time. To do this:

1. At the READY prompt, enter: 

Q

2.
Click the Manual capture icon  on the History pane toolbar. 

The screen is added to the list of screens in the History pane.
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Saving the history to a file
To save the recorded history to a file:

1.
Click the Export history to file icon on the History pane toolbar. 

The History Export dialog box appears.

2. Navigate to where you want to save the history file.

3. In the File name field, type DemoHistory.

4. Click Save. 

You now have a number of screens to use in your customization project.

5.
Click the History icon  on the Rumba toolbar. 

The History pane closes.

6. Select Connection > Disconnect.

Opening the Screen Designer
To open the Screen Designer, do one of the following :

• On the menu bar, select Rumba+ > Open Screen Designer.
•

On the toolbar, click the Open Screen Designer icon .
•

On the History pane toolbar, click the Customize captured screens icon .

The Screen Designer window appears, with two tabbed pages, the Screen Design page and the Rule
Manager page.

The project toolbar

Start a new project.

Open an existing project.

Import an existing project

Save a project.

Save a project with a different name.

Toggle the grid.

Change the opacity of displayed controls.

Show / hide Rule Manager controls.

Change project settings.

Import history.
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Generate a customization file.

Close the Screen Designer.

The Screen Design page

Screen Designer tabs and toolbar.

History pane. Contains thumbnails of all the screens recorded in the imported history file,
together with a search box to search and filter screens.

Work area. Contains a full size version of the selected thumbnail. Shows the controls
associated with the screen.

Control panel. Contains a list of available controls that can be applied to the screen in the
work area.

Property grid. Contains a list of available properties for the selected control.

Property description. Provides a description of the selected property in the property grid.

Status bar. Displays the coordinates of the cursor. Useful when looking for coordinates of
fields.

The Rule Manager page
For information about the Rule Manager and when to use it, see Using the Rule Manager.

Starting a new project
1. Click the New project icon  on the project toolbar. 

The New Rumba+ Project dialog appears.
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2. In the Name field, type a name for your project, such as DemoHost, then click OK.

Importing history

1. Click the Import History icon  on the project toolbar. 

The History Import dialog box appears.

2. Choose your history file, then click Open. 

Thumbnails of the recorded screens appear in the history pane. Each screen has a unique screen ID,
generated by Rumba. You can also create screen identifications instead of, or in addition to this default
ID (see Identifying screens).

The first screen is selected by default and a larger version of it appears in the work area:

3. Click the Save Project icon  on the project toolbar. 

Note: It is always good practice to save your project after you have made any changes to it.

Selecting a theme
A theme defines the layout of the screen and the look of each control across all screens in a customization
project.

It is best to choose a theme early in the customization project.

To select a theme:

1. Click the Project Settings icon on the project toolbar. 

The Project Settings dialog box appears.

2. Click Themes in the left pane.

3. Click Change in the right pane. The Choose Rumba+ Theme dialog box appears.

4. Select the thumbnail of the theme you want to use from the left pane.

5. Click OK.
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6. Click OK in the Project Settings dialog box. 

The theme is applied to all the screens in your project.

For more information about themes, see Using themes.

Adding controls
You will now use the Screen Design page to add controls to your screens.

The Screen Design page is used to add controls to specific screens. To add controls that repeat on
multiple screens or many times on a single screen, you use the Rule Manager. For information about the
Rule Manager, see Using the Rule Manager.

As you go through this section, you add controls to your captured screens progressively. We recommend
that you add the controls in the order they are described to build a completed project.

Note: It is important to remember that, while the Screen Designer is a very powerful tool, it is not
WYSIWYG. You should always adopt an approach of design and test to ensure that what you do in
the Screen Designer has the desired appearance in Rumba+ mode.

Adding a Button control
Button triggers an action or a sequence of actions when clicked.

Note: In this section you use the MF_Logo.png file supplied with the package file.

1. Ensure the first thumbnail is selected.

2. Drag the Button control icon from the control panel on to the work area and drop it to the left of the
AVAILABLE SYSTEM IDS ARE row. 

Note: When you drop the control on the screen, the property grid is populated.

3. In the property grid, click in the Caption field and delete the text Button.

4. Type Micro Focus SupportLine. 

When you click elsewhere on the screen, the text changes on the control.

5. To make the text appear on two lines, click in the Caption field and place your cursor after Micro
Focus, then press Alt+Enter. This splits the line.

6. Use the control's handles to size the control to fit the text.

7. Click in the Tooltip field and type SupportLine Web Site. 

8. Click the accelerator button  next to the Actions field. 

The Actions dialog box appears.

9. Under Select type, select WebSite from the drop-down list.

10.Click Add. 

A new action appears in the Actions frame and its properties appear in the Properties frame.

11.In the Properties frame, type http://supportline.microfocus.com/ in the ActionTarget field: 
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12.Click OK. 

Your screen should look like this:

13.You can also use an image for the button instead of text. To do this, select Image from the Mode list.

14.Click the accelerator button next to ImagePath. 

The Open dialog box appears.

15.Select the MF_Logo.png file supplied with this document.

16.Click Open. 

The image appears on the button.

17.Resize the button to 6x1. 

Your screen should look like this:
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Note: You can also provide a link to an image that is not on your machine. To do this, check
LinkedResource, then type the Web address of the image.

18.Click the Save icon  on the project toolbar.

Adding a Chooser control
Chooser appears on the screen like a drop-down list. Chooser is used to insert data into a field on the
screen by selecting an item from the list.

1. Drag the Chooser control icon from the control panel on to the work area and drop it next to ENTER
SYSTEM ID: 

2. In the property grid, click the accelerator button  next to ChooserItems. 

The ChooserItems dialog box appears:

Using the Screen Designer | 19



3. Click the Add button .

4. In the Properties frame, type Select Host in the Caption field.

5. In the Tooltip field, type Select host system. 

This text will appear as you hover over the selection. Tooltip text can be used for tips and helpful
information on the selection.

6. Leave the Value to Insert field empty.

7. Click the Add button .

8. In the Properties frame, type WYLBUR in the Caption field.

9. In the Tooltip field, type Select WYLBUR.

10.In the Value to Insert field, type WYL. 

This is the text that will be placed in the entry field and must match the commands you would normally
manually type in the field.

The ChooserItems dialog box looks like this:

11.Repeat the above steps to add the following Chooser items: 

Caption Tooltip Value To Insert

TSO MVS/XA Select TSO MVS/XA TSOA

TSO MVS/XB Select TSO MVS/XB TSOQ

VM/370 Select VM/370 VM

When complete, the ChooserItems dialog box looks like this:
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12.When you have finished, click OK.
13.Use the handles on the control to size it so that the text shows correctly. 

Your screen should look like this:

14.In the property grid, click the accelerator button  next to TextInsertionLocation. 

The Select Screen Location window appears.
15.Select Location from the Select By list.
16.Click one space to the right of ENTER SYSTEM ID: at the location 12,29.

17.Click OK.
18.In the property grid, click the accelerator button  next to Actions. 

The Actions dialog box appears.
19.From the Select type list, select Emulation Command.
20.Click Add.
21.From the Action list, select Enter. 

This action sends an Enter command to the host after the Chooser sends the selected text to the
screen location specified by TextInsertionLocation.

22.Click the Save icon  on the project toolbar.

Adding a Tooltip control
Tooltip displays text when the mouse hovers over the screen area that Tooltip occupies.
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1. Drag the Tooltip control icon from the control panel on to the work area and drop it on top of ENTER
SYSTEM ID:

2. Drag the handles on the control so the control covers the screen text: 

3. In the property grid, type the following in the Caption field: 

Click drop-down list to select system

4. Click in the Caption field and position your cursor just before to. 
5. Press Alt+Enter. 

The line splits into two.
6. Click the Save icon  on the project toolbar.

Adding an AutoExecution control
After you log into Demo Host, you need to press Enter twice before the READY prompt appears. You can
use an AutoExecution control to automate this sequence. To do this:

1. In the left pane, select the second screen. 

A larger version of the screen appears in the work area.
2. Drag the AutoExecution control from the control panel and drop it to the right of the Rumba icon: 
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3. In the property grid, click the accelerator button  next to the Actions field.

4. From the Select type list, select Emulation Command. 

5. Click Add.

6. From the Action list, select Enter:

7. Click OK.

8. Select the third screen in the left pane:

9. Add another AutoExecution control and give it the same properties: 

10.Click the Save icon  on the project toolbar.

Adding an Image control
Image masks an area of a screen with either a color or an image.

Note: In this section you use the welcome.png file supplied with the package file.

1. In the history pane, scroll down and select the fourth thumbnail. This shows the READY prompt. 

A larger version of the screen appears in the work area:
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2. Drag the Image control icon from the control panel onto the work area, size it to 15x66, then place the
top left corner at the screen location (3,3): 

3. In the property grid, select Image from the Type drop-down list. 

The ImagePath field appears.

4. Click the accelerator button  next to the ImagePath field. 

The Open dialog box appears.

5. Navigate to where you have saved the welcome.jpg file, select the file, then click Open. 

The selected image now fills the control on the screen:
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Note: You can also provide a link to an image that is not on your machine. To do this, check
LinkedResource, then type the Web address of the image.

6. Click the Save icon  on the project toolbar.

Adding a Label control
Label adds a text label to a green screen. You can use Label to either replace an existing screen label or
create a new label.

1. In the history pane, select the SALES ORDER ENTRY - CUSTOMER SCREEN. 

A larger version of the screen appears in the work area.

2. Drag the Label control icon from the control panel on to the work area and drop it on top of the
Contract field.

3. Size the control so it covers the field completely: 

4. In the property grid, uncheck HostText. 

The LabelText field appears.

5. In the LabelText field, delete the default text Label and type Date:
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6. Select Right from the Alignment list.

7. Check OverrideColorsSettings. 

The control now uses the screen background and foreground colors for the label background and the
text. The label text is now visible in the control:

8. Click the Save icon  on the project toolbar.

Adding a Calendar control
Calendar inserts a selected date at a specified point on the screen.

1. Ensure the SALES ORDER ENTRY - CUSTOMER SCREEN screen is still displayed in the work area.

2. Drag the Calendar control icon from the control panel on to the work area and drop it to the left of the
(new) Date field: 

3. In the property grid, click the accelerator button  next to the InsertedDateFormat field. 

The Date Format dialog box appears:
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You can select from a variety of supplied date formats. Alternatively, you can specify a custom date
format.

4. In the field at the top of the dialog box, type MM-dd-yy, then click Add. 

The date format is added to the main list.

5. Click OK. 

The dialog box closes and the date format appears in the InsertedDateFormat field.

6. In the Tooltip field, type Select date

7. Click the accelerator button  next to the TextInsertionLocation field. 

The Select Screen Location window appears.

8. Select Location from the Select By list.

9. Click one space to the right of the Contract field at screen location (3,52).

10.Click OK. 

The window closes and the coordinates appear in the TextInsertionLocation field. In this case, 3,52.
The coordinates also appear in the status bar, below the property grid.

When complete, the property grid looks like this:

11.Click the Save icon  on the project toolbar.

Adding a GridCollector control
GridCollector gathers information from a specific screen location and displays the information in a table.
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1. In the left pane, scroll down and select the EUROPEAN CUSTOMER LIST screen. 

2. Drag the GridCollector control from the control panel and drop it at the start of the first row: 

3. In the property grid, in the Name field, delete GridCollector and type CustomerList.

4. Click the Edit icon  on the control. 

The GridCollector frame appears:
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5. Move and size the GridCollector frame so that it overlays the screen data: 

6. Click the accelerator button  next to the Columns field. 

The Columns dialog box appears:

7. In the Name field, delete GridCollectorColumn, and type Account.
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8. Click the Add button . 

Another item appears in the Column Items frame.

9. In the Name field, type Sales Rep.

10.Click the Add button . 

Another item appears in the Column Items frame.

11.Continue to add columns for:

• Vol/Yr

• Cum Rev

• Country

The dialog box should loook like this:

12.Click OK. 

The GridCollector frame now contains a number of blue vertical lines. These represent column dividers.

13.Drag each column divider to the left of each column. 

The GridCollector should look like this:

Tip: In some cases, such as Web applications, system parameters do not look for leading spaces.
It is therefore best to start a column on the first character of data.

14.At the top right of the GridCollector, click the Save icon .
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15.Click the Save icon  on the project toolbar.

Adding a Table control
This section describes how to add a Table control and link it to the GridCollector control.

1. Drag the Table control from the property grid and drop it on the GridCollector control. 

The table automatically links to the GridCollector control and maps on to the area defined by the
GridCollector:

Note: The LinkedGridCollectorName field in the property is completed automatically, and the
table header and columns properties are taken from the linked GridCollector properties.

2. Uncheck IsMoreButtonVisible.

3. Uncheck IsAutoNavigateOnLoad.

4. Check IsExportButtonVisible.

5. Click the Save icon  on the project toolbar.

Adding a Collector control
Collector controls gather screen data for use in other functions. In this case you will add a Collector control
to collect data to generate a pie chart for January.

1. In the history pane, select the TOPCO TOYS, INC Revenue Analysis By Region screen. 

A larger version of the screen appears in the work area.

2. Drag the Collector control icon from the control panel on to the work area and drop it on top of 305 in
the JAN column for region 1.

3. In the property grid, type R1Jtoy in the Name field. 

This is the name of the variable where the value will be stored.

4. Leave Trim Spaces checked.

5. Add Collector controls for the three other regions. Use R2Jtoy, R3Jtoy, and R4Jtoy as global
parameter names. 

The Screen Design page looks like this:
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6. Click the Save icon  on the project toolbar.

Adding a WebFrame control
In the previous section, you added four Collector controls to collect data for a pie chart. You will now add a
WebFrame control to use the variables of the Collector controls to generate the pie chart.

Note: In this section you use the WebFrame_URL.txt file and pie chart.png files supplied with
the package file.

1. Drag the WebFrame control icon from the control panel on to the work area and drop it just underneath
JAN: 

2. Select Pop-up from the Mode list. 

Note: If you were to select Embedded, the resulting pie chart would appear as an embedded
window on the green screen.

3. Click the accelerator button  next to ImagePath and select the pie chart.png file that came with
this document.

4. In the Tooltip field, type Pie chart.
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5. Open the WebFrame_URL.txt file. 

The file contains the following URL:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%
%&chdl=Region1|Region2|Region3|Region4&chtt=TOYS

6. Copy the content of the file and paste it in the URLSource field.

7. Click the Save icon  on the project toolbar.

Adding a Tab control
Tab provides an area of the screen to which you can assign other controls. You can have multiple Tab
controls on a screen, with multiple tab items within a Tab control.

1. In the history pane, select the SALES ORDER ENTRY - DETAIL LINE ENTRY SCREEN. 

A larger version of the screen appears in the work area.

2. Drag the Tab control icon from the control panel to work area and drop it on the Remarks area on the
screen: 

3. In the property grid, click the accelerator button  next to the TabItems field. 

The TabItems dialog box appears:

4. In the Caption field, delete Tab Item and type Order.

Using the Screen Designer | 33



5. Click the Add button . 

Another item appears in the Properties frame.

6. In the Name field, delete Tab Item and type Quantity.

7. Click the Add button . 

Another item appears in the Properties frame.

8. In the Name field, delete Tab Item and type Approved. 

The dialog box looks like this:

9. Click OK. 

The Tab control now as three Tab items:

You can change the width of the tab item headers to fit the text you choose. For example, the default
width is eight characters. You can specify a different width by changing the value in the HeaderSize
field:

10.Change the value in the HeaderSize field to 12. 

You can see the change in the width of the tab item headers.

Note: If you select Dynamic from the HeaderWidth list, the headers automatically size to fit the
length of text in ech header.
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11.In the property grid, click the down button  next to the Color field. 

The Available Colors palette appears:

12.Select RoyalBlue: 

The color fills the Tab control and its Tab items:

13.Click the Save icon  on the project toolbar.

Adding an InputField control
InputField provides a text input field in which you type text at a specific screen location.

1. Each input field requires a label. Drag the Label control icon from the control panel and drop it onto the
Tab control you have created: 
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2. In the property grid, uncheck HostText. 

The LabelText field appears.

3. In the LabelText field, delete the default text Label and type Order Number:.

4. Add another Label control below the first and call it Status:.

5. Size both labels: 

6. Drag the InputField control icon from the control panel and drop it on the Order Number row: 

7. Click the accelerator button  next to the TextInsertionLocation field. 

The Select Screen Location window appears.

8. Click in the Order Number field, then click OK. 

The coordinates 3,16 appear in the TextInsertionLocation field.

9. Check OverrideColorsSettings. 

The Tab item currently looks like this:

10.Click the Quantity tab.

11.Drag the Label control icon onto the tab item.

12.Uncheck HostText and call the label Product Number:.

13.Size the label.

14.Add another label below the first, call it Quantity:, then size it. 

The Tab item should look like this:

15.Add an InputField control on the Product Number row.
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16.Open the Screen Location window and click in the Product Number field.

17.Click OK. 

The coordinates 6,18 appear in the TextInsertionLocation field.

18.Check OverrideColorsSettings.

19.Add an InputField control on the Quantity row.

20.Open the Screen Location window and click in the Order Qty field.

21.Click OK. 

The coordinates 8,18 appear in the TextInsertionLocation field.

22.Check OverrideColorsSettings. 

The Tab item should look like this:

23.Click the Approved tab.

24.Drag the Label control icon onto the tab item.

25.Uncheck HostText, call the label Approval:, then size the label: 

26.Click the Save icon  on the project toolbar.

Adding a RadioButton control
RadioButton adds text at a specified screen location.

This section uses the Tab control you created previously.

1. Click the Order tab: 

2. Drag the RadioButton control from the control panel and drop it on the Status row: 

3. In the property grid, delete RadioButton from the Caption field and type Open.

4. In the GroupName field, type OrderStatus.

5. Open the Screen Location window from the TextInsertionLocation accelerator button.
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6. Click in the Status field on the top row of the green screen.

7. Click OK. 

The coordinates 3,33 appear in the TextInsertionLocation field.

8. In the TextToSend field, type Open. 

The property grid should look like this:

9. Drag the RadioButton control from the property grid and drop it below the Open radio button: 

10.In the property grid, delete RadioButton from the Caption field and type Shipped.

11.In the GroupName field, type OrderStatus.

12.Open the Screen Location window from the TextInsertionLocation accelerator button.

13.Click in the Status field on the top row of the green screen.

14.Click OK. 

The coordinates 3,33 appear in the TextInsertionLocation field.

15.In the TextToSend field, type Shipped.

16.Click the accelerator button  next to the Actions field. 

The Actions window appears.

17.Select Email from the Select type list, then click Add.

18.In the ActionTarget field, type: customer@address.com

19.Click OK. 

The Tab item should look like this:

20.Click the Save icon  on the project toolbar.

Adding a CheckBox control
CheckBox acts like an on/off toggle in the same way as a typical check box.
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This section uses the Tab control you created previously.

1. Click the Approved tab: 

2. Drag the CheckBox control from the control panel and drop it on the Approval row: 

3. In the property grid, delete CheckBox in the Caption field and type Approved.

4. Click the accelerator button next to the TextInsertionLocation field. 

The Screen Location window appears.

5. Click in the Status field on the Line Number row, then click OK. The coordinates 5,57 appear in the
TextInsertionLocation field.

6. Under CheckedState, type Approved in the TextToSend field.

7. Under UncheckedState, type Pending in the TextToSend field. 

The property grid should look like this:

The Tab item should look like this:

8. Click the Save icon  on the project toolbar.

Generating a customization file
You must now generate all the controls and rules you have created to a customization file. You will then link
the file to a mainframe session.

To generate the customization file:
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1. Click the Generate customization file icon  on the project toolbar. 

The Save Rumba Designer Archive dialog appears.
2. In the File name field, type a name for the file, such as DemoHost.
3. Click Save.

Closing the Screen Designer
To close the Screen Designer, click the Close Screen Designer icon on the project toolbar.

Associating the customization file with a host session
The final step is to associate the customization file with a host session. To do this:
1. On the Rumba desktop, select Rumba+ > Rumba+ Mode.
2. Select Rumba+ > Settings. 

The Rumba+ Settings window appears.
3. Next to the Associate Rumba Designer Archive field, click Browse. 

The Associate Customization File dialog box appears.
4. Choose the customization file you created, then click Open.
5. In the Rumba+ Settings window, click OK.

Testing the screens
1. Select Connection > Connect. 

The mainframe screen appears in Rumba+ mode, showing the controls you added to it:

2. Hover your mouse over the Micro Focus button. 

The tooltip text you created appears:
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3. Hover your mouse over ENTER SYSTEM ID: 

The tooltip text you created appears:

4. From the drop-down list, select TSO MVS/XA. The AutoExecution action you specified in the Chooser
automatically sends an Enter command to execute the system selection. The additional AutoExecution
controls you created send Enter commands automatically at the ENTER LOGON ID: and LAST
SYSTEM ACCESS prompts, presenting you with the READY prompt screen and the image you added
with the Image control:

5. At the READY prompt, enter: 

O

The SALES ORDER ENTRY CUSTOMER SCREEN appears:

This screen contains the Date label and Calendar control you created:
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6. Hover your mouse over the Calendar control. 

The tooltip text you entered appears:

7. Click the Calendar control. 

A calendar appears:

8. Select today's date. 

The date appears:

9. Press PF3.

10.At the READY prompt, enter C. 

The EUROPEAN CUSTOMER LIST screen appears, showing the table you created with the
GridCollector and Table controls:
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11.Click Export at the top right of the table. 

The Save As dialog appears.

12.Specify a name for the table and click Save. The contents of the table are saved in .CSV format.

13.Press PF1.

14.At the READY prompt, enter: 

TOYS

15.At the TOPCO TOYS, INC screen, click the WebFrame control under JAN. 

The pie chart you created appears in a separate window:

16.Close the pie chart window.

17.In the TOPCO TOYS, INC screen, press Enter.

18.At the READY prompt, enter: 

O

The SALES ORDER ENTRY CUSTOMER SCREEN appears.

19.Press PF8. 

The SALES ORDER ENTRY DETAIL LINE ENTRY SCREEN appears, showing the Tab control you
created:

20.On the Order Tab item, in the Order Number field, type 12345. 

The number appears in the Order Number field on the green screen.

21.Select the Open radio button. 

The text Open appears in the Status field next to the order number.
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22.Select the Shipped radio button. 

The text Shipped replaces Open in the Status field:

Your default email client opens a new message window so you can advise the customer that the order
has shipped.

23.Click the Quantity tab.

24.In the Product Number field, type ABC77701. 

The text appears in the Product Number field.

25.In the Quantity field. type 25. 

The text appears in the Order Qty field:

26.Click the Approved tab.

27.Check Approved. 

The check box is unchecked and the text Pending appears in the second Status field.

28.Check Approved again. 

The check box is checked and the text Approved appears in the second Status field.

The screen looks like this:

29.Select Connection > Disconnect.
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Using the Rule Manager
Use the Rule Manager to add controls that repeat on multiple screens or many times on a single screen.

The Rule Manager page

Screen Designer tabs and toolbar.

Control panel. Contains a list of the following actions:

New Rule Opens the Rule Wizard to create a new rule.

Edit Rule Opens the selected rule in the Rule Wizard for editing.

Delete Rule Deletes the selected rule.

Enable Rule Enables the selected rule, if disabled.

Disable Rule Disables the selected rule.

Duplicate Rule Creates a copy of the selected rule.

The control panel also contains:

• Buttons to move a rule up, down, or to the top or bottom of a list.
• A search box to search rules.

List of rules pane. Contains a list of configured rules. Each rule consists of:

• A description.
•

An icon to use the rule to filter screens .
• An icon to show whether the rule is enabled 
•

An icon to show whether the rule is disabled 
•

An icon to edit the rule 
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•
An icon to delete the rule 

Rule description pane. Displays a natural language version of the rule.

The Rule Wizard
The Rule Wizard help you to define rules and conditions that govern what actions occur on a screen ad
when.

Steps pane. Contains the steps you need to go through to create a rule. The current step is
highlighted.

Options pane. Contains the options available for the selected step:

When this step is highlighted ... The options pane contains ...

Step 1 A list of templates that you can use to build
a rule.

Step 2 Conditions that identify the screen the rule
will apply to.

Step 3 The field, location, or text to look for on the
screen.

Step 4 The controls to create according to the rules.

Step 5 Exceptions to the rules that select screens.

Rule description pane. Contains a natural language version of the rule.

The Rule Wizard also contains the following command buttons:
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Click this ... To do this ...

Cancel Close the Rule Wizard without saving any changes.

Back Go back to the previous step.

Next Go to the next step.

Finish Finish creating the rule and return to the Rule Wizard main screen.

When to use the Rule Manager
The following basic scenarios describe when to use the Rule Manager instead of the Screen Design page.

• Adding Tooltip or Button controls to entire applications.

Fields with specialized Tooltip controls or assistance which remain consistent within the application.
Especially useful to explain account, customer, and status information that is abbreviated or appears in
abbreviated form on the screen.

Buttons such as Exit, Clear (screen), and Reset (keyboard).
• Adding controls to screens within subsystems.

Controls which are consistent with major subsystems such as accounts payable, help ticket systems, or
customer lookup. A subsystem might consist of five to ten screens, but operator functions are consistent
throughout.

Screen content can change, but header information needs to offer similar modernization control.
• Data scroll areas with modernizations that repeat on each line.

One Rumba+ rule can generate multiple modernizations.

Tip: If you find that a control on the Screen Design page might be used better as a rule, right-click
the control and select Move to Rule Manager from the pop-up menu. The Screen Designer
moves the control to the Rule Manager where you can edit it.

Adding Tooltip or Button controls to entire applications
A simple system Clear button is designed with a rule that places it on every screen of the application in the
top right corner.

Button controls like this help users who are not used to the rules that apply to 3270 / 5250 protocols.
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Adding controls to screens within subsystems
In this example, the administrator wants to help users identify an account status. Anywhere in the
application where the string ACCOUNT STATUS : AB appears, a tooltip appears so that the operator
knows that the account status is active with credit approved.

The rule first finds the character string, then places a tooltip over the entire string. Moving the mouse over
the abbreviated field provides in a more detailed description.

Adding rules to be used on a set of screens
This example shows three screens in an application called Master Inquiry. The screens are similar, but
have different input prompts and different data headings. Each screen would be identified automatically as
a different screen.
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The example creates a rule that puts a Create New Customer button near the first entry field.

The rule for this button is based on the Master Inquiry screen designation. If the screen identifies itself as
Master Inquiry and the string 5=display is found, the rule automatically puts a button by the
5=display field. On screens that do not match the criteria, no button is created. The button is
programmed with the keystrokes to initiate the creation of a customer record within the application.
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Adding controls to each line on a screen
This example uses screens containing tables of data and adds the same controls to each line on the
display. If you were to use the Screen Designer page you would need to add a separate control for each
line of each table. However, instead, you can use rules to replicate controls on each line.
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To select a customer, the user types 1, then presses Enter. The example sets up a rule that replaces these
actions.

Note: The number of data entries per page varies. The rule creates 10 static selections per page. As
a result, the last page will only have three buttons because only three selections are valid.
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The rule looks for the character strings Select Customer and 1 Select. It then replaces the single
character input field with a button labeled SEL. This button replaces the two actions of typing 1 in the data
field and pressing Enter with a simple point and click.

Because the rule looks for the input field, if that input field is not found, the control is not added to the
screen.
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Types of control

AutoExecution
AutoExecution is used to trigger a sequence of actions when a green screen appears. The control is not
visible in a Rumba+ session.

Properties:

Name Default value Description

Actions Empty list One or many actions are executed
sequentially from the top to the
bottom in the specified list.

Button
Button is used to trigger a sequence of actions when clicked. The control can include text or an image.

Properties:

Name Default value Description

Mode Text Specifies the type of content for the
control. Can be Text or Image.

Caption Button The text to be displayed on the
button.

LinkedResource Unchecked When checked, allows you to specify
a full Web address to create a link to
an image.

Only available if Mode is Image.

ImagePath Empty string Clicking the accelerator button opens
the Open dialog box which allows you
to select an image file with a format of
JPG, GIF, or PNG. The image file is
copied to the project folder and saved
with the project.

Only available if Mode is Image.

ImagePosition Stretch Specifies the position of the image
inside the button:

Stretch (default)
Fill
Fit
Center

Tooltip The tool tip is displayed when the
mouse pointer hovers over the button.

If empty, the button’s caption is
displayed.
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Name Default value Description

Actions Empty list One or many actions which are
executed sequentially from the top to
the bottom in the specified list.

Style Default The button style.

OverrideColorsSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Calendar
Calendar is used to pick a date and is initially displayed on the screen as an icon. Calendar opens when
you click the icon. It closes on losing focus, or when you select a date.

When you select a date in the date picker, the date is inserted on the screen at the coordinates defined by
TextInsertionLocation. The format used is defined by InsertedDateFormat.

If the field occupied by Calendar contains date, the field is used by Calendar when it opens. Otherwise,
Calendar uses the current date.

Properties:

Name Default value Description

TextInsertionLocation InPlace The (row,column) where the control is
inserted on the screen. InPlace
means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
TextInsertionLocation field.

InsertedDateFormat Empty string Specifies the format of the text
representing the date format.
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Name Default value Description

If empty, the default date format is
used:

dd/MM/yyyy

For example, 03/01/2014.

Tooltip Empty string If empty, no tool tip is displayed.

Using the Date Format dialog box
Use the Date Format dialog box either to select a predefined date format or to create a customized date
format.

Selecting date formats
To select a date format other than the default:

1. Click the accelerator button  next to the InsertedDateFormat field in the property grid. 

The Date Format dialog box appears.

2. Select a date format from the list shown, then click OK. 

The dialog box closes and the chosen date format appears in the InsertedDateFormat field.

Using customized date formats
To use a customized date format:

1. Type the format you want in the field at the top of the Date Format dialog box. 

Note: Day and year must always be specified in lower case. Month must always be specified in
upper case.

2. Click Add. 

The custom format appears in the main list.

3. Click OK. 

The dialog box closes and the chosen date format appears in the InsertedDateFormat field.

4. To remove a custom format from the list, select the format, then click Remove. 

Note: You can only remove custom formats, not a supplied format.

Custom date format specification
The table below describes the date formats you can use with the Calendar control.

Format specifier Description Example Interpretation

j Represents the sequence
number of a day in the
calendar year.

j displays values between 1,
which represents January
1, and 366, which
represents December 31 in
a leap year.

j-yy

j-yyyy

The date 1/1/2014, j is
displayed as 1-14.

The date 12/31/2014,

j is displayed as 365-2014.

Types of control | 57



Format specifier Description Example Interpretation

jjj Represents the sequence
number of a day in the
calendar year.

jjj displays values between
1, which represents
January 1, and 366, which
represents December 31 in
a leap year.

For jjj, values less than 100
are padded with a leading
zero or zeros.

jjj-yy

jjj-yyyy

The date 1/1/2014, jjj is
displayed as 001-14.

The date 12/31/2014, jjj is
displayed as 365-2014.

d The day of the month, from
1 through 31.

M/d/yyyy

M/d/yy

For the date 6/1/14, d is
interpreted as 1.

For the date 6/15/14, d is
interpreted as 15.

dd The day of the month, from
1 through 31.

M/dd/yyyy

M/dd/yy

For the date 6/1/2014

dd is interpreted as 01.

For the date: 6/15/14

dd interpreted as 15.

ddd The abbreviated name of
the day of the week.

M-ddd-yyyy

M-ddd-yy

For the date 6-Mon-2014,
ddd is interpreted as Mon
(for EN-US).

For the date 6-lun.-14, ddd
is interpreted as lun. (for
FR)

.

dddd The full name of the day of
the week.

M-dddd-yyyy

M-dddd-yy

For the date 6- Monday
-2014

dddd is interpreted as
Monday (for EN-US).

For the date 6- lundi -14,
dddd is interpreted as
lundi (for FR).

M The month, from 1 through
12.

M-dd-yyyy For the date 6/15/2014, M
is interpreted as 6.

For the date 12/15/2014, M
is interpreted as 12.

MM The month, from 01 through
12.

MM-dd-yyyy For the date 06/15/2014,
MM is interpreted as 06.

For the date 12/15/2014,
MM is interpreted as 12.

MMM The abbreviated name of
the month.

MMM-dd-yyyy For the date Jun-15-2014,
MMM is interpreted as Jun
(for EN-US).
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Format specifier Description Example Interpretation

For the date juin-15-2014,
MMM is interpreted as juin
(for FR).

MMMM The full name of the month. MMMM-dd-yyyy For the date
January-15-2014, MMMM
is interpreted as January
(for EN-US).

y Represents only the last
digit of the year.

M-dd-y For the date 2-03-14, y is
interpreted as 4.

While Calendar is opened
by the user, Rumba adds
the current decade digit to
the left. That is, the year
would be set to 14 (2014)

yy The year, from 00 to 99. M-dd-yy For the date 6-15-14, yy is
interpreted as 14.

yyyy The year, as a four-digit
number.

M-dd-yyyy For the date 6-15-2014,
yyyy is interpreted as 2014.

Any string Data separators. Examples:

M dd yyyy

M-dd-yyyy

M/dd/yyyy

M#dd#yyyy

CheckBox
The CheckBox control acts as an on/off toggle control in the same way as a typical check box.

CheckBox provides the user with the choice of one of two options, such as Yes and No.

Properties:

Name Default value Description

TextInsertionLocation InPlace The (row,column) where the text is
inserted on the screen. InPlace
means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
TextInsertionLocation field.

CheckedState Empty string The text to be used at the specified
screen location and any specified
actions to be performed if the check
box is checked.
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Name Default value Description

UncheckedState Empty string The text to be used at the specified
screen location and any specified
actions to be performed if the check
box is unchecked.

Caption Check Box The label text that appears next to the
check box.

Tooltip Empty string The tool tip text that appears when
the mouse hovers over the control.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available which, when selected,
override the Style property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen background color is
used as the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used as
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette for choosing the text
color. Only available if Foreground is
set to CustomColors.

Chooser
Chooser is displayed on the screen as a drop-down control. Chooser is used to insert data into a field on
the screen by selecting an item from the list.

Auto-complete is supported.

Properties:

Name Default value Description

ChooserItems Empty list The list of items displayed by the
drop-down list when clicking the down
arrow. The list of items can be
imported from a .csv file (see
below). Each item is specified by
Caption, Tooltip, and ValueToInsert.
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Name Default value Description

Caption The text to be displayed on the drop-
down list item.

Tooltip The text to be displayed by ToolTip
when the mouse cursor hovers over
the drop-down list item.

ValueToInsert Specifies the text to be inserted when
selecting an item from the list.

IsAutoCompleteEnabled Checked When checked, Chooser
automatically offers a case-insensitive
matching item to be selected from the
list. If the user is not typing in the
screen field occupied by Chooser, no
suggestions are made.

IsEditable Checked When checked, data can be typed
into the field that Chooser is using. If
unchecked, data can only be selected
from the drop-down list.

TextInsertionLocation InPlace The (row,column) where the text is
inserted on the screen. InPlace
means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
TextInsertionLocation field.

Actions Empty list A collection of actions to be
performed when a Chooser item is
selected.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.
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Name Default value Description

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette fro choosing the text
color. Only available if Foreground is
set to CustomColors.

Importing items from a .csv file

To use this feature successfully, the contents of the .csv file must be in the following format:

<CAP><DEL><TIP><DEL><VAL>

where:

This ... Denotes this ...

<CAP> Caption.

<DEL> Delimiter (;). This is the only supported delimiter.

<TIP> Tool tip.

<VAL> Value to insert.

For example:

#First block

AAA;BBB;CCC

AAA;BBB;CCC

DDD;EEE;ZZZ

GGG;HHH;III

JJJ;KKK;LLL

MMM;NNN;OOO

To import a .csv file:

1. Click the accelerator button next to ChooserItems in the property grid.
2. In the ChooserItems dialog box, click the Import icon.
3. Select the .csv file.
4. Click OK.

Collector
Collector is not visible in a Rumba+ session. It is used to copy text from the screen location of the Collector
to the session database. The screen location of the Collectoris defined by the two pairs (Row Offset,
Column Offset), (Row Span, Column Span).

The database lifetime is the whole session. Data is collected when host screen appears as a list of (key,
value) pairs of strings. The data can be used by other controls only from the current session. When the
screen location of the Collector spans screen rows, appropriate line breaks are inserted into the collected
data.

For example, a Button control looking like a small handset icon can be set up with an action
Run_Application to run Skype. Additional_Arguments of this action can use a phone number stored by
the Collector located in a phone number field on another screen of the session.

Properties:
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Name Default value Description

Name Empty string A name of the Collector control.

Name also specifies a key to be used
by a Collector when copying data
from the Collector screen location to
the database.

Data stored with the same key more
than once is overwritten.

Data can be accessed later in the
session by using the syntax:

%%PhoneNumber%%

where PhoneNumber is the global
variable name.

TrimSpaces Checked When checked, whitespace
characters are not copied to the
database. When unchecked,
whitespace characters are included in
the data.

GridCollector
The GridCollector control is an extended version of the Collector control. Collector collects data as text
from a specific screen location. GridCollector collects data as a table (grid).

The control stores the collected information in a database for the lifetime of the current session. The
information can be used by any other control.

To configure GridCollector properties, click the Edit Mode button at the top right corner of the control.
When you have finished, click either the Save and Exit button or the Cancel Edit Mode button.

Properties:

Name Default value Description

Name GridCollector The name for a GridCollector. Must
be unique.

Columns GridCollector Column Columns collection. Each column has
one property:

Name: Non-empty string.

IncludesHeader Checked When checked, the selection includes
the table header.

AvoidDuplications Checked When checked, duplicate rows are
not collected.

MultiPageNavigation Checked When checked, the following
properties are enabled:

MaxPages
AIDKey
EndCondition

MaxPagesToLookUp 1 Integer. The number of additional
pages that are fetched ahead each
time the fetch operation is triggered
by one of the controls that uses the
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Name Default value Description

GridCollector data. The GridCollector
implements the fetching mechanism
(not the control that uses the
GridCollector) .

NavigationAidKey PF8 The AID key for fetching the next
page.

EndOfDataConditions Clicking the accelerator key opens
the EndOfDataConditions dialog
box (see below).

EndOfDataConditions properties
Name Default value Description

SameData When selected, data collection stops
if duplicate data is found. Default.

Note: If this is the only stop
condition that is defined,
SameData cannot be deleted.

EmptyLine When selected, data collection stops
if an empty line is found.

Text When selected, data collection stops
if:

either:

The specified non-empty string is
found at the specified screen location.

or:

The specified string is empty and
nothing is found at the specified
screen location.

EndOfDataText The text to search. Available if Text is
selected.

EndOfDataTextLocation Location of the text. This is one of the
following:

• The whole screen, as specified by
the string Anywhere.

• A specific location on the screen,
specified in the Screen Location
dialog box. To open this dialog
box, click the accelerator button
next to the
EndOfDataTextLocation field.

EndOfDataTextRow The row of the text.

EndOfDataTextColumn The column of the text.
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Note: GridCollector checks stop conditions from the top to the bottom of the list until any condition is
met, then stops collecting data. In this way, you can re-order conditions to collect different amounts of
data from the same screens.

Syntax
Any control that wants to use the data from the GridCollector can get the data by using the following
syntax:

%%GridCollector_Name[Row_Number,Column_Name]%%

Examples:

%%Customers[5,Address]%% Defines getting the address of the entry 5.

%%Customers[*,Address]%% Defines getting the address of all customers. This can be
useful for setting a list control's items source.

%%Customers[3,*]%% Defines getting all data for the customer at the third row.

%%Customers[*,*]%% Defines getting GridCollector data for all customers.

On a Rumba+ screen, each time new data appears on the screen, the data is added to the GridCollector
table.

Image
Image control is used to mask an area on the screen. The control appears in a Rumba+ session without a
frame, and can be filled with one of the following:

Color If UseBackgroundFromHost is checked, Image is filled with the host background color. If
UseBackgroundFromHost is unchecked, you can select the fill color from the palette. The
default color is black. If you select a transparent fill, the Image control is invisible on the screen.

Image If you do not select a valid image, or provide a valid URL, the Image control is invisible on the
screen.

You can change the opacity of the Image control on the Screen Design page to show the contents of the
screen behind the control. To do this, select the control, then click the icon on the top right corner of the
control's frame.

Properties:

Name Default value Description

Type Color Can be either Color or Image.

UseBackgroundFromHost Checked Only available if Type is Color.

Color Black Fill color. Only available if Type is
Color and
UseBackgroundFromHost is
unchecked.

LinkedResource Unchecked When checked, allows you to specify
a full Web address to create a link to
an image.

Only available if Type is Image.

ImagePath Empty string Clicking the accelerator button opens
the Open dialog box which allows you
to select an image file with a format of
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Name Default value Description

JPG, GIF, or PNG. The image files is
copied to the project folder and saved
with the project.

Only available if Type is Image.

You can also use the Collector control
to provide the image path.

ImagePosition Stretch Position and size of the selected
image. Can be one of the following:

Stretch (default)
Fill
Fit
Tile
Center

InputField
The InputField control provides a text input field into which the user types text which is inserted at a
specified screen location.

For example, InputField can be used to modernize or rationalize the layout of a screen with a number of
input fields. InputField controls can be placed where they are most useful. The information the user types
into them is then inserted in the screen locations of the traditional editable areas.

Note: When the control is used in a Rumba+ screen, the input field displays the value from the screen
location, at the specified length. However, if the screen location is a protected field, no data is read
and no typing is allowed in the InputField control..

In addition, if the length is 0 (the default value), data is read until the end of the green screen field the
control refers to, and the number of characters is limited by the length of the green screen.

Properties:

Name Default value Description

TextInsertionLocation InPlace The (row,column) where the text is
inserted on the screen. InPlace
means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
TextInsertionLocation field.

Length 0 The maximum number of characters
that the input field can contain. A
value of 0 means the number of
characters is limited by the length of
the green screen field.

Tooltip Empty string A tool tip that describes the control.
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Name Default value Description

IsNumeric False Specifies whether the input is
numeric or for all characters.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette for choosing the text
color. Only available if Foreground is
set to CustomColors.

IsPassword Unchecked When checked, an asterisk (*) is used
to masked the typed characters.

Label
The Label control is a single line control which is used to place any static text at a specified location on a
screen.

Properties:

Name Default value Description

HostText Checked When checked, the host text located
at (StartRow,StartColumn) is used
as the label text. When unchecked,
LabelText is made available.

LabelText Label If HostText is unchecked, this
specifies the custom text to be
displayed on the label.

TextLocation InPlace The (row,column) where the label text
on the screen should be taken.
InPlace means the label text should
be taken from the location of the
control as specified on the Screen
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Name Default value Description

Design page, or from the location of
the logical marker defined by the
SearchFor condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
TextLocation field.

TextLength 0 Specifies the number of characters in
the label text.

Alignment Left Specifies the alignment of the label
text:

Left
Center
Right

OverrideColorsSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

RadioButton
The RadioButton control is used to add text at a specified screen location.

Properties:

Name Default value Description

TextInsertionLocation InPlace The (row,column) where the text is
inserted on the screen. InPlace
means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.
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Name Default value Description

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
TextInsertionLocation field.

Caption RadioButton The text to be displayed on the
control.

Tooltip Empty string The tool tip text that appears when
the mouse hovers over the control.

GroupName Empty string The radio button group this radio
button belongs to.

SelectedState Empty string The text to be used at the specified
screen location and any specified
actions to be performed if the check
box is checked.

UnselectedState Empty string The text to be used at the specified
screen location and any specified
actions to be performed if the check
box is not checked.

OverrideStyleSettings Unchecked The text to be used at the specified
screen location and any specified
actions to be performed if the check
box is checked.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen background color is
used as the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used as
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette for choosing the text
color. Only available if Foreground is
set to CustomColors.

Tab
Tab provides an area of the screen to which you can assign other controls. You can have multiple Tab
controls on a screen, with multiple tab items within a Tab control.
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To assign a control to a tab item, drag the control on to the appropriate tab item.

When you select another tab item, that tab item is shown, together with its controls.

Notes:

• Deleting a tab item deletes all its assigned controls.
• Deleting a Tab control deletes all its tab items and their assigned controls.

Properties:

Name Default value Description

TabItems Empty collection Lists all tab items and their controls.
Each tab item has a caption.

HostBackground Unchecked When checked, the Tab control uses
the background color of the host
screen. When unchecked, the control
uses the color defined by the Color
property.

Color White Smoke Specifies the background color of the
Tab control.

HeaderWidth Static Specifies the width of the tab item
headers. Static sets a fixed width
specified by HeaderSize. Dynamic
sets a variable width according to the
length of the header text.

HeaderSize 8 Specifies the fixed width of the tab
item headers.

Table
The Table control formats data from multiple screens as a scrollable table with filtering and sorting
capabilities.

The Table control uses a pre-defined GridCollector control as its data source. If there is already one, single
GridCollector on the screen, the Table control links to it automatically. If there is no GridCollector on the
screen, you must link to a GridCollector manually using the LinkedGridCollectorName property.

Properties:

Name Default value Description

LinkedGridCollectorName Name of the GridCollector control to
which the Table control is linked.

Columns Collection of columns.

Title Name of the linked
GridCollector column.

The visible column title.

IsVisible Checked When checked, the control is visible
on a Rumba+ screen.

ColumnAliasInGridCollector Name of the GridCollector column
from where the data will be taken.

ColumnType String Can be one of:

String
Number
Date
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Name Default value Description

ColumnDateFormat Format of dates in the selected
column.

ColumnAlignment Left Aligns the cell text. Can be one of:

Left
Center
Right

IsHeaderVisible Unchecked When checked, the table shows the
column headers.

IsAutoNavigateOnLoad Checked When checked, the Table control
triggers the GridCollector to fetch the
next pages automatically when the
Table control is activated.

IsFilterable Checked When checked, adds a Filter field to
the table. The typed value filters out
all rows except those with strings or a
string prefix that match filter text in a
column.

IsMoreButtonVisible Checked When checked, adds a More button is
enabled to the table title bar. More
pages down the screen until there is
no more table data.

IsExportButtonVisible Unchecked When checked, adds an Export
button to the table title bar. This
allows the user to export the table
contents to a comma-delimited .csv
file for use in Microsoft Excel.

DefaultRowCommand Actions performed when the user
double-clicks a row. When creating
actions, the following syntax can be
used to take the text from any table
cell in a row that is double-clicked:

##ColumnAliasInGridCollec
tor##

The following syntax can also be used
to take text from any Collector control:

%% GlobalVariableName%%

Tooltip
The Tooltip control is activated when the mouse pointer hovers over the screen area that Tooltip occupies.

There are two modes for Tooltip:

Static mode Where the content of Tooltip is a free string. The string can include global parameters
set by Collectors.

Advanced mode Where Tooltip can read text from screen location and use it as the displayed text.

Properties:
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Name Default value Description

Caption Empty string Specifies the text displayed by Tooltip.
Data stored by Collector controls can
be used.

Advanced Unchecked When checked, activates advanced
mode.

KeyTextLocation InPlace The (row,column) where the text
should be taken from the screen.
InPlace means the location of the
control as specified on the Screen
Design page, or the location of the
logical marker defined by the
SearchFor condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
KeyTextLocation field.

TooltipItems Advanced mode only.

Importing items from a .csv file

To use this feature successfully, the contents of the .csv file must be in the following format:

<KEY><DEL><TIP>

where:

This ... Denotes this ...

<KEY> Key representing on-screen emulation text.

<DEL> Delimiter (;). This is the only supported delimiter.

<TIP> Tooltip text.

For example:

#Tool Tip values

TSO;TSO log on

Password;Enter your password

Application required;Enter your CICS application name

Userid;Enter your user ID

To import a .csv file:

1. Click the accelerator button next to TooltipItems in the property grid.
2. In the TooltipItems dialog box, click the Import icon.
3. Select the .csv file.
4. Click OK.

WebFrame
WebFrame is a control, which can be displayed either as an icon or as an embedded window on the
screen. An icon looking like a small globe can be set to open a map based on the postal address displayed
in the host screen field. An embedded window displays content at a specified Web address when the
screen arrives.
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Properties:

Name Default value Description

Mode Pop-up Specifies whether WebFrame is
displayed as an icon (Pop-up) or as
an embedded window (Embedded).

LinkedResource Unchecked When checked, a link to an icon
image, specified by ImagePath, is
stored in the customization project.
When unchecked, an icon image file,
specified by ImagePath, is stored in
the customization project. Enabled
only if Mode is Pop-up.

URLSource Empty string Any valid Web address. The data
stored by Collector controls can be
used to specify the target.

ImagePath Empty string Clicking the accelerator button opens
the Open dialog box which allows you
to select an image file with a format of
JPG, GIF, or PNG. When
LinkedResource is unchecked, the
image file is copied to the project
folder and saved with the project.

Width 500 Window width in pixels.

Height 500 Window height in pixels.

Tooltip If empty, no tool tip is displayed.
Otherwise, specifies the text that
Tooltip displays when the mouse
hovers over the WebFrame icon.

Shared properties
Each of the following properties may be used by more than one type of control:

Name Default value Description

Name Specifies a custom name for one or
more controls.

Note: If a rule creates more
than one control of the same
type on the same screen, the
following naming convention is
used:

<name>,
<name>_1, ...
<name>_<name>

ControlTarget RumbaMainArea The control target is the region
specified in the currently selected
theme, where the control is placed.
RumbaMainArea is the region
occupied by the green screen.

Style Empty string Style defines the look of a control. Its
possible values are displayed in the
list of items taken from the currently
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Name Default value Description

selected theme. If not specified, the
default style is used.

UseBackgroundFromHost Unchecked When checked, a control acquires its
background color coming from host.
When unchecked, the background
color defined by the control’s style is
used.

UseForegroundFromHost Unchecked When checked, a control acquires its
foreground color coming from host.
When unchecked, the foreground
color defined by the control’s style is
used.

RowOffset 0 Vertical offset relative to the row
where the logical marker is located.
Logical markers are defined by the
SearchFor condition. A positive or
negative value defines the screen
location as the number of rows down
or up the logical marker.

A wrong offset value can adversely
displace the control.

ColumnOffset 0 Horizontal offset relative to the
column where the logical marker is
located. Logical markers are defined
by the SearchFor condition. A positive
or negative value defines the screen
location as the number of columns
from the right or left of the logical
marker.

A wrong offset value can adversely
displace the control.

RowSpan 0 If not zero, overrides the height of a
logical marker defined by the
SearchFor condition.

ColumnSpan 0 If not zero, overrides the width of a
logical marker defined by the
SearchFor condition.

ZOrder The highest ZOrder value of all
controls on the current screen on the
Screen Design page except Topmost
+ 1

Specifies the stacking order of a two
or more controls. Controls with higher
ZOrder values appear further up the
stack or closer to the foreground.

Actions
Action Description Values

SetText Inserts text into the
specified screen location of
an unprotected field.

If the specified location is
not in any unprotected field,
no action is performed.

TextInsertionLocation The (row,column) where the
control is inserted on the
screen. InPlace means the
location of the control as
specified on the Screen
Design page, or the location
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Action Description Values

of the logical marker defined
by the SearchFor condition.

The screen location can also
be defined by using the
Select Screen Location
window, opened by clicking
the accelerator button next to
the TextInsertionLocation
field.

ActionTarget The text to be inserted.

EmulationCommand Runs a specified emulation
command.

EmulationCommand Possible values are shown in a
list.

ClearField Clears the contents of a
specified field at s specified
screen location.

FieldLocation The (row,column) where the field is
located on the screen. InPlace means
the location of the control as specified
on the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by clicking
the accelerator button next to the
FieldLocation field.

WebSite Runs the user’s default
browser to navigate to a
specified Web site.

ActionTarget Web site address. Data stored by
Collector controls can be used to
specify arguments.

RunApplication Run a specified application
on the user's machine.

Rumba Desktop:

ActionTarget

Command line to run. For example:

C:\Program Files (x86)\Skype\Phone
\Skype.exe

AdditionalArguments

Application arguments. For example:

/callto:+555555

Rumba+ Mobile:

MobileURI

iPhone registered Uniform Resource Identifier (URI)
scheme name. For example:

skype://666-666-666?call

Rumba+ Web:

WebURI

Registered Uniform Resource Identifier (URI)
scheme name. For example:
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Action Description Values

skype:+666-666-666?call

Data stored by Collector controls can be used to
specify parameters for ActionTarget and
AdditionalArguments.

RunMacro Runs a specified macro
with the Rumba Engine.

ActionTarget Full path to the macro file to run, or the
path relative to the Rumba macros
folder. Data stored by Collector controls
can be used to specify arguments.

RunScript Runs a specified script with
the Rumba Script Engine.

ActionTarget Full path to the script file to run, or the
path relative to the Rumba scripts
folder. Data stored by Collector controls
can be used to specify arguments.

SetCursor Places the cursor at the
specified screen location.

CursorLocation The (row,column) where the cursor
should be placed on the screen.
InPlace means the location of the
control as specified on the Screen
Design page, or the location of the
logical marker defined by the
SearchFor condition.

The screen location can also be
defined by using the Select Screen
Location window, opened by
clicking the accelerator button next
to the CursorLocation field.

SetValueToAVariable Creates a global variable
and sets its value. If the
global variable already
exists, its value is reset.

GlobalVariableName The name of the global variable.

Content The value of the global variable.

Expressions containing values of
other already existing global
variables may be used in the
form %
%<other_variable_name>
%%.

Email Sends an email to a
specified address.

ActionTarget The recipient’s email address.

The control context menu
When you right-click a control, a context menu appears with the following menu options:

Option Description

Convert to Rule Converts a static control on the Screen Design page to a
dynamic control managed by the Rule Manager.

Cut Cuts a control to the Screen Designer clipboard.

Copy Copies a control to the Screen Designer clipboard.
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Option Description

Paste Pastes a control from the Screen Designer clipboard to
the screen that is currently displayed in the working area
of the Screen Design page.

Delete Deletes a control.

Disable / Enable Disables a control so that it remains in your project, but is
not used in the customized screen. An exclamation mark
appears at the top right of the control to show that it is
disabled. To enable a control, right-click the control and
select Enable from the pop-up menu.

You can still edit disabled controls but they will not be
used on a customized screen until you enable them.

If you copy a disabled control or convert it to a rule, the
control remains disabled.

Send to Back If two or more controls appear over each other, this option
sends the selected control to the back of the stack of
controls.

Bring to Front If two or more controls appear over each other, this option
brings the selected control to the top of the stack of
controls.
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How To
This section contains additional about the Screen Designer, controls, and rules.

Use themes
A theme defines the layout of the screen and the look of each control across all screens in a customization
project.

The screen layout is defined as having a rectangular main area in the center, which might be surrounded
by rectangular areas (margins).

The following themes are included in Rumba:

• Rumba Green Screen
• Rumba+ Green Screen
• Rumba+ Windows

The main area of a screen can contain any type of control. However, margins can contain only buttons.
Margins are defined by the theme you use.

If you change a theme, the margins of the previous theme disappear, together with all the button controls
they contain. It is therefore best to choose a theme early in the customization project.

Search history screens
You can search the thumbnail screens in the history pane for text strings that appear either on a screen or
as part of a screen ID.

At the bottom of the history pane, type a search string in the search field . The thumbnails are filtered,
leaving only those screens that contain the search string.

Identify screens

About screen identification
The Screen Designer supports the following ways of identifying screens:

Default An identification, where Rumba calculates a screen ID from a screen's field data. Used by
default.

To customize screens, a screen ID must be assigned to each screen. Unfortunately, this
default screen ID might not be sufficient. This occurs when several screens, which have to
be distinguished, get the same screen ID. It can also occur when several screens, which
have to be addressed as the same, get different screen IDs.

Selection
based

An identification based on one screen selection. When the default screen ID is not
sufficient, you can select the contents of a particular screen location to act as the screen ID.
The selection is limited to the height of one row on the screen.
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Note: Before you start to customize the screens in your project, you must choose either the default
screen ID type or a selection based screen ID type. You cannot change the screen ID type once you
have started to customize a screen.

Custom screen
identification

For each screen recorded during your session you can define a custom identification
algorithm. For custom screen identification, you define a set of selected areas on a
screen and specify a name for them. This defines screen data to distinguish a
particular screen from other screens in your project. The custom identification name is
assigned as a screen ID to each screen of your project that has exactly the same data
in exactly the same selected areas as your custom identification.

You can choose either selection based selection screen identification, custom screen identification, or a
combination of both. In this way, you can either distinguish between screens which otherwise would have
had the same ID, or identify similar screens which otherwise would have had different IDs.

Specifying selection based screen identification
1. Click the Project Settings icon on the project toolbar. 

The Project Settings window appears.
2. On the Screen ID page, click Select next to Selection Based. 

The Selection window appears.
3. Select a screen thumbnail in the left pane.
4. In the work area, select the text portion on the screen by drawing a rectangular border within a single

screen row with the mouse. 

The selected text is added as an ID to any screen in your project that has the same text in the same
location.

5. Click OK. 

Note: Make only one selection before clicking OK.

6. Click OK in the Project Settings window.

Removing a selection:

To remove a selection, right-click the selection and select Remove This Selection from the pop-up menu.

Using custom screen identification

Manage controls

Changing the opacity level
You can use the slider on the project toolbar to change the opacity of all controls on a screen from full
opacity to 20% opacity.

Clicking the Opacity level icon displays the opacity slider and toggles the set opacity on and off.

Selecting multiple controls
You can select more than one control at any time so you can perform the same action once on the selected
controls, instead of once for each control.

You can select controls in one of the following ways:
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• Use your mouse to draw an area of the screen containing the controls you want to select.
• Press Ctrl+A to select all controls on the screen.
• Right-click the screen background and select Select All.
• Use Ctrl+Click to toggle whether a screen is selected.

You can perform the following actions on the selected controls:

• Move (using the mouse or arrow keys)
• Delete
• Cut
• Copy
• Paste
• Duplicate

Note: You cannot select Rule Manager controls as part of a multiple selection.

Working with rule controls
Rule controls are controls created using the Rule Manager.

About rule controls
When you create rule controls, they also appear on the Screen Design page. By default, this feature is
turned on. You can toggle between showing and hiding rule controls using the toggle icon on the project
toolbar.

Rule controls are designed to be used on multiple screens. They are therefore shown on the Screen
Design page in a different style to single-screen controls so you can easily differentiate between them.

You can edit rule controls from the Screen Design page in the same way as in the Rule Manager.
However, you cannot resize, move, delete, copy, or duplicate these controls in the Screen Design page, as
shown by a small padlock in the top right corner of the control.

Editing rule controls
In the same way as a single-screen control, you can edit the control's properties using the property grid.

1. To edit a rule control from the Screen Design page, right-click the control and select Edit Rule from the
pop-up menu. 

The rule opens in the Rule Wizard.

Note: When you edit one rule control, it affects all the controls created by the source rule.

2. To view a rule control, right-click the control and select Show Rule from the pop-up menu. 

The rule opens in the Rule Manager.

Use Web components in Rumba+
Rumba+ can call both applications and Web components using one or more of the following controls:

Button A labeled UI control. It can call an application, script, URL, or Web page.

WebFrame Creates an icon using an image. You can set the size of the frame. Only valid for Web
browser URLs. No address bar is displayed.
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Passing parameters to an application or Web page
You pass parameters to an application or Web page using the Collector control. Collector is placed over the
data fields that Rumba+ uses to capture data. When the application runs, there is nothing to show on the
screen that indicates this is a data collection field.

You add Collector controls on the Screen Design page:

Note: The Collector control should cover the entire data field to accommodate long strings.

When you configure a Collector control, you give it a name in the property grid. This name must be unique
in the customization file. You can refer to the data stored in the database as %%Name%%. In the figure above
the Name is MapCity and its global variable name is %%MapCity%%.

The Trim Spaces property resizes the length of the data string by removing trailing spaces. In most
applications, this option should be 1.

Creating Web objects and URLs
The first thing to do is to create a working URL using a known set of parameters for a known address. For
example, this Google Maps parameter is for an Office Park in Maryland:

http://maps.google.com/maps?q=700 King Farm,Rockville,MD

Copy the working URL to an editor such as Notepad so you can edit it for use in the Screen Designer. For
example, the following string re-creates the address string:

%%MapAddr%%,%%MapCity%%,%%MapState%%

Note that the commas (,) used as delimiters in the Google command, are still in place in the Rumba+
string. The command to copy and paste into the Screen Designer is:

http://maps.google.com/maps?q=%%MapAddr%%,%%MapCity%%,%%MapState%%

As the character strings get more complex, testing becomes more important. For example, the following
string calls a Google charting facility for a pie chart. Notice that the original URL contains a section that
deals with both chart labels (AREA-A,etc) and chart data (T=:100,300,200,50). Other editable data
includes colors, format, and sizing:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|FF0000|
FFFF00&chds=0,1000&chd=t:100,300,200,50&chdl=AREA-A|AREA-B|AREA-C|AREA-D&chtt=TOYS
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As in the Google Maps example, we need to replace the data portion of this URL with variables collected
from the Rumba+ screen. In this case, the data portion (specified by chd), becomes:

chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%%

And the new URL to include in the Screen Designer becomes:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%
%&chdl=Region1|Region2|Region3|Region4&chtt=TOYS

In a real application, you might also want to modify the label data dynamically as well. A label section might
therefore look like this:

chdl=%%Label1%%|%%Label2%%|%%Lable3%%|%%Lable4%%

You can experiment with the Google pie chart URL using the TOYS screen on the Rumba Demo Host. For
information about connecting to the Demo Host and accessing the TOYS screen, see Connecting to the
Demo Host.

Generate customization files for Rumba+ Web and Rumba
+ Mobile

The Rumba+ Server Build Tool allows you to build Rumba+ Web and Rumba+ Mobile application
deployment packages.

The tool uses the customization output from the Rumba Screen Designer to create a Web Application
aRchive (.war) file. The .war file contains a rules file and other resources, such as images, macros, and
scripts.

The file is then deployed to an application server for implementation.

Note: The Rumba+ Server Build Tool is supplied with Micro Focus Rumba+ Web and Micro Focus
Rumba+ Mobile.

You can also generate customization files using the Screen Designer command line. See Use the Screen
Designer command line.

Exporting a customization file
For information about exporting a customization file, refer to the Rumba+ Server Build Tool 1.1: Help.

Deploying a .war file
For information about deploying a .war file to an application server, refer to the Rumba+ Server 1.1:
Administrator Guide.

Import additional projects
You can import additional customization projects to merge with a project that is currently open in the
Screen Designer.

To do this, click the Import Project icon  on the project toolbar.

Notes:

• You cannot import a project if the base project is not open.
• The project name and theme will be the same as the currently open project.
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The table below provides information about some circumstances where not all data might be included in an
import.

If this happens ... Then this happens ...

The screen ID configuration of the other project is
different from the one defined in the base project.

Following the import attempt, the operation halts with an
error message.

You import a project in which custom screen IDs are
defined.

If all the custom screen IDs are valid, they are added to
the custom screen IDs list of the base project.

You import a project in which custom screen IDs are
defined. However, one of the custom screen ID names
already exists in the base project, although the custom
screen IDs are not identical.

The custom screen ID is added to the project with a new
name: Origcustom screen ID - Copy,
Origcustom screen ID - Copy (2). Any
references to the renamed custom screen ID are
changed accordingly.

You import a project with a rule which is identical to one
of the rules in the base project.

Duplicated rules appear only once.

You import a project in which custom screen IDs are
defined. One of the custom screen IDs is not valid
because it is assigned to a screen that has another
custom screen ID.

Not all of the new custom screen ID’s related rules are
merged into the project. Information is shown in the
results dialog box.

You import a project that includes a local resource. If the name of the resource already exists, you can select
one of:

• Copy and Replace

• Don’t Copy

• Copy, but keep both files

You can also import additional customization projects using the Screen Designer command line. See Use
the Screen Designer command line.

Use the Screen Designer command line
You can use the Screen Designer command line to:

• Generate one or more customization files from a Screen Designer project files.
• Import multiple projects to a current Screen Designer project.

Syntax

<RumbaInstallDir>\System\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe [/P
<project_file_path> | /L <project_file_list_path>] [/O <output_dir>][/S] | /I
<config_file> | /?

where:

<RumbaInstallDir> is the folder where Rumba is installed.

/P <project_file_path> is the fully qualified path to a single project file.

/L <project_file_list_path> is the fully qualified path to a file that contains a list of project files.

Each path and file name must be on a separate line. Each line can
commented out by using # as the first character.

/O <output_dir> is the fully qualified path of where to export the customization files.
Optional. If not specified, the <RumbaInstallDir>\System
\Plus\ScreenDesigner folder is used.
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/S saves the project after the customization files is generated.

/I <config_file> is the fully qualified path of the configured list of projects to import.

/? shows this information on the screen.

Generating customization files

Syntax

<RumbaInstallDir>\System\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe [/P
<project_file_path> | /L <project_file_list_path>] [/O <output_dir>][/S]

Example: Generating a single customization file

RumbaScreenDesignerCLI.exe /P C:\Users\<user_name>\AppData\Local\Micro Focus
\Rumba\Plus\Projects\TableTest\TableTest.rsdp /O C:\Users\<user_name>\AppData
\Local\Micro Focus\Rumba\Plus\Rules /S

Example: Generating multiple customization files

RumbaScreenDesignerCLI.exe /L C:\Rumba\Projects\ProjectList.txt /O C:\Users
\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Rules /S

Example project file list contents:

C:\Users\<user name>\AppData\Local\Micro Focus\Rumba\Plus\Projects\u1\u1.rsdp
#C:\Users\<user name>\AppData\Local\Micro Focus\Rumba\Plus\Projects\unique
\unique.rsdp
C:\Users\<user name>\AppData\Local\Micro Focus\Rumba\Plus\Projects\TableTest
\TableTest.rsdp
C:\Users\<user name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\longtable3\longtable3.rsdp
C:\work\rumba_mobile\TestApplications\TestPlanAppCSIMVS\TestAppCSIMVS
\TestAppCSIMVS.rsdp

Note: You can use the pound character (#) to comment out a line.

Importing project files

Syntax

<RumbaInstallDir>\System\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe /I
<config_file>

Example

<RumbaInstallDir>\System\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe /I C:
\Rumba\Projects\ImportFileList.txt

Example project file list contents:

duplicateresource=ckb
baseproject=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects1\MergeProjects1.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects2\MergeProjects2.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects3\MergeProjects3.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects2\MergeProjects2.rsdp
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project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\a1\a1.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\WYSIWYG\WYSIWYG\WYSIWYG.rsdp
saveto=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects20

where:

duplicateresource specifies duplicate resource copy options:

cr Copy and replace.

dc Do not copy.

ckb Copy, but keep both files.

baseproject is the base project that the projects will be imported to.

project is the absolute or relative path to the project file.

saveto is the path of the resulting merged project. If not specified, the base project is used.
If the project does not exist, a new project is created at that location with a name
matching the folder name. For example, if the path is:

C:\Users\user_name>\AppData\Local\Micro Focus\Rumba\Plus
\Projects\MergeProjects20

the created project is called MergeProjects20.

Use the standalone Screen Designer
As well as using the Screen designer from the Rumba Desktop, you can also use it a standalone
application. You can use the standalone Screen Designer whether Rumba is running or not.

1. From the Windows Start menu, select Start > All Programs > Micro Focus Rumba > Rumba Tools >
Micro Focus Rumba Screen Designer. 

The Screen Designer starts as a standalone application.

2. To close the Screen Designer, click the window's Close icon.

You can use the standalone Screen Designer whether Rumba is running or not. However, it is very useful
to run Rumba at the same time. For example, you can make changes to a project in the standalone Screen
Designer, generate the customization file, switch to Rumba then, once the project has been loaded once,
simply toggle Rumba+ mode off and on to see the result of your changes straight away.
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Contacting Micro Focus
Micro Focus is committed to providing world-class technical support and consulting services. Micro Focus
provides worldwide support, delivering timely, reliable service to ensure every customer's business
success.

All customers who are under a maintenance and support contract, as well as prospective customers who
are evaluating products are eligible for customer support. Our highly trained staff respond to your requests
as quickly and professionally as possible.

Visit http://supportline.microfocus.com/assistedservices.asp to communicate directly with Micro Focus
SupportLine to resolve your issues or e-mail supportline@microfocus.com.

Visit Micro Focus SupportLine at http://supportline.microfocus.com for up-to-date support news and access
to other support information. First time users may be required to register.

Information needed by Micro Focus SupportLine
When contacting Micro Focus SupportLine, please include the following information, if possible. The more
information you can give, the better Micro Focus SupportLine can help you.

• The name and version number of all products that you think might be causing an issue.
• Your computer make and model.
• System information such as operating system name and version, processors, and memory details.
• Any detailed description of the issue, including steps to reproduce the issue.
• Exact wording of any error messages involved.
• Your serial number. To find this number, look in the subject line and body of your Electronic Product

Delivery Notice e-mail that you received from Micro Focus.

Additional information needed by Micro Focus
SupportLine

If reporting a protection violation, you might be asked to provide a dump (.dmp) file. To produce a dump
file, use the Unexpected Error dialog box that is displayed when a protection violation occurs.

Unless requested by Micro Focus SupportLine, leave the dump setting as Normal (recommended), click
Dump, then specify a location and name for the dump file. Once the dump file has been written, you can e-
mail it to Micro Focus SupportLine.

You may also be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a tracing
infrastructure that enables you to quickly and easily produce diagnostic information detailing the operation
of a number of Micro Focus software components.
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Tell Us What You Think
We welcome your feedback regarding Micro Focus documentation.

Send feedback about this Help documentation.

Click the above link to email your comments to Micro Focus.
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